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1. FOCUS STACKING: BASIC CONCEPT
1.1. What is focus stacking?

1.1.1. Use this technique when the depth of field you can achieve in a 
single capture isn’t wide enough to obtain sharp focus on all the scene 
elements that you want to have sharp.

1.1.2. To focus stack, take two or a series of photos (“brackets”) of the 
same composition, moving the focals plane between each bracket, then 
assemble the brackets into one photo (“render the stack”).

1.2. Focus stacking is useful in two types of photography.
1.2.1. Use focus stacking in landscape photography:

1.2.1.1. If your composition has an object very close to your camera 
position (think flowers or rocks as a foreground element) and using a 
wide angle lens at a very small aperture (to widen your depth of field) 
will render your background (think mountains) too small and soft, so 
then you choose a longer focal length lens and your resulting depth of 
field is not wide enough to obtain a sharp foreground (your flowers or 
rocks), your middle ground (whatever it might be) and your background 
(your mountains), OR 

1.2.1.2. If your composition requires a telephoto lens to compress your 
scene and the composition is close to you (think standing on the bank of 
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a small creek shooting a detailed scene of rocks, roots and rivulets) and 
you can’t get sharp focus on all elements even if you use a very small 
aperture such as f/16 or f/22.

1.2.2. Use focus stacking in macro or close up photography:
1.2.2.1. Macro and Close Up Photography Defined

1.2.2.1.1.  Macro photography means the size of the subject is equal to 
or greater than the image of the subject on the sensor; and

1.2.2.1.2.  Close up photography is not technically macro photography, 
but the subject is really close anyway).   

1.2.2.2.   In macro and some close up photography, the distance to the 
subject makes it difficult or impossible to keep the entire subject in 
sharp focus, regardless of aperture.

1.2.2.3. Controlling depth of field
1.2.2.3.1.  In some close up photography, even if a small aperture will 

allow reasonable sharpness of the subject, 
1.2.2.3.2.  you may want to throw the background out of focus 
1.2.2.3.3.  (think of a flower in the field where you want to capture the 

flower but set it off from the leaves, twigs and other flowers in the 
background). 

1.2.2.3.4.  Use focus stacking with a larger aperture to get your flower 
sharp throughout and leave your background unfocused.

1.2.2.4. Getting Close – most lenses won’t focus close enough on their 
own, so:
1.2.2.4.1.  Use a dedicated macro lens;
1.2.2.4.2.  Use extension tubes or a bellows between your camera and 

lens;
1.2.2.4.3.  Use a close focus filter; OR
1.2.2.4.4.  Use an adapter to mount your lens to your camera in reverse 

(rendering your lens fully manual).

1.3. Other uses of focus stacking mentioned in the literature:
1.3.1. Use focus stacking to avoid diffraction
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1.3.1.1. At smaller apertures, image softness results from the bending of 
light rays through the lens.

1.3.1.2. When decreasing the aperture to improve sharpness yields more 
softness due to diffraction, your lens is said to be “diffraction limited.”  

1.3.1.3. May not be a practical problem in most cases, but something you 
should be aware of.

1.3.2. Use focus stacking so that you can use the “sweet spot” of your lens
1.3.2.1. Every lens has an aperture where it is the sharpest.
1.3.2.2. Again this isn’t a practical problem in most cases, but also 

something you should be aware of.

2. FIELD WORK:  TAKING FOCUS STACKING 
“BRACKETS”
2.1. Move the Focal Plane

2.1.1. Recall that to take our focus stacking brackets, we must move the 
focal plane between each bracket

2.1.2. There are two ways to move the focal plane. Either:
2.1.2.1. with your camera stationary, shift the focal plane by shifting the 

lens focus farther from or nearer to the camera (we can call this “change 
lens focus”); OR 

2.1.2.2. without changing the lens focus, move the camera closer to or 
farther from the subject so that the focal plane moves along the subject 
(we can call this “move the camera”). 

2.2. Ways to Change Lens Focus
2.2.1. Manually, by changing lens focus with the focus ring.
2.2.2. Automated by camera

2.2.2.1. Some cameras have settings that can be used to shift the focal 
plane automatically for a series of brackets.

2.2.2.2. These tend to be mirrorless cameras.
2.2.2.2.1.  Olympus cameras have had focus bracketing for many years.
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2.2.2.2.2.  Sony just added bracketing to its popular Alpha 7R series in 
the forthcoming V.

2.2.2.2.3.  Canon has focus bracketing in its R series mirrorless cameras,
as well as the 90D and M6 MkII and a couple of Powershots.

2.2.2.2.4.  Nikon started with focus bracketing in its D850 and now in 
its mirrorless models.  

2.2.2.2.5.  Panasonic Lumix has focus stacking in its G models. 
2.2.2.3. Focus Stacking vs. Focus Bracketing

2.2.2.3.1.Some of these cameras will also render the brackets into a new
“focus stacked” image.

2.2.2.3.2.Others will take the brackets, but leave rendering of the 
brackets to you or other software. 

2.2.2.4. Automated by camera doesn’t work if there is no connection 
between the camera and the lens (such as with some macro tubes or 
bellows or when reversing the lens).     

2.2.3. Applications and camera control devices exist that can be used to 
control the camera to shift the focal plane and take a series of brackets.  
These include:
2.2.3.1. Helicon Remote (an application that controls lens focus via a 

computer-to-camera connection); 
2.2.3.2. CamRanger (a device to wirelessly control many functions on 

certain cameras, including automatic focus bracketing); and
2.2.3.3. Helicon FB Tube (HeliconSoft, the developer of the Helicon 

Remote and Helicon Focus software, has in the past sold a macro 
extension tube for either Canon EF or Nikon F mount cameras and 
lenses that can be used to change the lens focus while taking the 
brackets.  According to their website, the FB Tube is out of production 
due to the war in Ukraine (HeliconSoft is located in eastern Ukraine 
near the Russian border)).

2.3. Ways to Move the Camera
2.3.1. Focus Rails
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2.3.1.1. Also sometimes call macro rails or slides.
2.3.1.2. Fix the camera on the rail, then move the camera along the rail.
2.3.1.3. Can be by hand or motorized.

2.3.2. Hand Held – see the quick and dirty method below.

2.4. The Exposure Triangle in Focus Stacking
2.4.1. Aperture: use an aperture that will give each successive bracket 

sufficient depth of field to overlap the depths of field of the nearer and 
farther brackets.  

2.4.2. Shutter speed:  select your shutter speed based upon any motion of 
the subject and whether you are hand holding your camera.

2.4.3. Adjust ISO to correct the exposure after setting the aperture and 
shutter speed.  If hand holding, consider increasing your ISO so that you 
can increase shutter speed.  Use a fixed ISO, not auto ISO.

2.4.4. Exposure settings for all brackets should be the same.
2.4.5. Use manual mode so you can select and fix your aperture, shutter 

speed and ISO.
2.4.6. An exception might be if the exposure range exceeds the camera’s 

capability so that you take some brackets at different exposure values so 
that you can blend the brackets for both depth of field and exposure.

2.5. Number of Brackets
2.5.1. The number of brackets you need can vary from two or three up to 

100 or more.
2.5.2. It all depends on the depth of field of each bracket and the distance 

from the nearest and farthest points in the composition that you want to 
have in sharp focus.

2.5.3. Use a depth of field calculator to determine the depth of field for 
each bracket at the aperture you have selected and the focus distance for the
bracket (your type of camera (for sensor size) and your lens focal length 
must be set in the calculator but will remain constant for each set of 
brackets).
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2.5.4. For macro photography focus stacking, use a macro depth of field 
calculator.

2.6. Taking the Brackets
2.6.1. General

2.6.1.1. Remember that the cleaner the composition the easier it will be 
for you, or your stacking app, to render the stack. 

2.6.1.2. Shoot RAW photos.
2.6.1.3. Overlap your brackets to avoid bands of softness.
2.6.1.4. Take more brackets than you think you will need.
2.6.1.5. Review your brackets in the field, making sure you have at least 

one bracket that is sharp in each area you want sharp.  
2.6.2. For landscape focus stacking

2.6.2.1. You will generally want to use a tripod.  All of the brackets must 
align perfectly.  Although some apps such as Photoshop can align the 
brackets, its much easier if they are already aligned. 

2.6.2.2. Take the first bracket with focus near the camera then take 
subsequent brackets while moving focus up the LCD screen.

2.6.2.3. No need to zig-zag across the LCD screen.
2.6.2.4. Brackets can be set by distance from the camera (bearing in mind 

the depth of field for each bracket at your aperture setting and lens focal 
length), OR

2.6.2.5. By focusing on the major areas you want in sharp focus.
2.6.3. For macro and close up photography with moving objects (think 

bugs), a quick and dirty approach may work.  
2.6.3.1. Hand hold your camera, put it in manual focus mode and burst 

mode, use a fast shutter speed (at least 1/250) and a smaller aperture 
(say f/8) then focus first on one end or the other of the subject and either
turn the lens focus ring or move the camera either in or out while taking 
a burst along the length of your subject.  
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2.6.3.2. If your camera has an electronic (silent) shutter, the better practice
is to use it.  You will be taking many shots and using the electronic 
shutter will save wear and tear on your mechanical shutter.   

2.6.4. For macro and closeup photography with a relatively stationary 
subject
2.6.4.1. Again, use a tripod.
2.6.4.2. Manually focus on the closest point you want in sharp focus.
2.6.4.3. If your camera does bracketing for focus stacking, by all means 

use it.  
2.6.4.4. If not, take your first bracket. 
2.6.4.5. Zoom in and refocus for each successive bracket, taking 

individual shots.
2.6.4.6. In general, you don’t need to zig zag left and right.  However, if 

you are shooting a relatively flat object and want to ensure sharpness 
throughout, use auto focus and take brackets in each of the four corners 
and the middle.

2.7. White Balance
2.7.1. Your white balance should be the same for all brackets.
2.7.2. Choose a white balance setting and fix it for all brackets or shoot 

RAWS and synchronize in Lightroom or other raw converter before 
rendering the stack.

2.8. Focus
2.8.1. Use a small AF target or manual focus so you can get the focus point 

for each bracket where you want it. 
2.8.2. If you use auto focus, switch to back button focus before focusing (or

switch to manual focus after focusing but before snapping) so that your 
camera doesn’t refocus when you take the shot.

2.9. Focus breathing
2.9.1. Some lenses change their focal length as you shift focus.  
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2.9.2. The farthest focal plane will have the smallest field of view and all of
your other brackets will be cropped to this field of view.  Thus, compose for
the farthest focal plane.

2.10. How do you know when you need to focus stack in landscape 
photography?
2.10.1. Take a photo focused one third into scene.  Zoom in and check focus 

at various points in depth of photo.  If everything you want to be sharp 
isn’t, then use focus stacking.

2.10.2. But see if you can get everything in the composition sharp that you 
want to be sharp by using a smaller aperture or by moving the focal plane 
nearer or farther from the camera.

2.10.3. Sometimes a focus stacked landscape image doesn’t look natural.  As
things get farther from us, they become softer and less distinct.  Add depth 
to an image by leaving more distant areas in softer focus.  Ask yourself:  
would you be able to see the entire scene in sharp focus?  If so, focus stack 
may be called for.  Otherwise, not so much.

2.10.4. Pay attention to the hyper-focal distance at the aperture and focal 
length you are using.  Focus at the hyper-focal distance to get your depth of
field from one half of the hyper-focal distance to infinity.  In practice, focus
just beyond the hyper-focal distance to avoid coming up short.  Determine 
hyper-focal distance by using a depth of field calculator such as the one in 
PhotoPills.

3. PROCESSING FOCUS STACKING “BRACKETS”
3.1. Basic Adjustments

3.1.1. Make basic adjustments in Lightroom or your other raw converter of 
choice (you generally want to do basic edits on your RAW file if possible).

3.1.2. First adjust one of the brackets (usually, the one with focus closest to 
the camera).

3.1.3. Don’t crop or sharpen it.
3.1.4. Perhaps adjust white balance. 
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3.1.5. Adjust exposure, contrast, highlights, shadows, lights and darks as 
needed.

3.1.6. Check lens corrections.
3.1.7. Synch the edited bracket to the other brackets.

3.2. Full featured apps with stacking capabilities
3.2.1. Photoshop,  Affinity Photo, On1 Photo Raw and Luminar Neo (with 

an extension) all have focus stacking capability built in.  Photoshop 
Elements will focus stack with an add-on called Elements+.  Among the 
full featured apps with stacking capabilities, I have used only Photoshop.

3.2.2. Photoshop’s automated procedure
3.2.2.1. Open the brackets you initially processed as explained above as 

layers in Photoshop
3.2.2.2. Arrange the layers (usually with closest on bottom, progressively 

to the top).  To reverse the order of layers select Layer > Arrange > 
Reverse.

3.2.2.3. Align the layers
3.2.2.3.1.  Select all layers
3.2.2.3.2. Select Edit > Auto Align Layers 

3.2.2.3.2.1.   Leave Auto Checked
3.2.2.3.2.2.   Select OK
3.2.2.3.2.3.   Ignore Vignette Removal and Geometric Distortion 

(these will probably have been dealt with in Lightroom).
3.2.2.3.3.  Auto align layers will take care of lens focus breathing.
3.2.2.3.4.  As mentioned above, you may lose part of your composition 

(depending upon the focus breathing of your lens).
3.2.2.3.5.  To get rid of white lines around the edge of the layers (which 

results from the alignment process), select C for crop, set the current 
ratio (upper left corner) to Original Ratio, move boundaries in as 
needed,  and check Delete Cropped Pixels, then select the check 
mark.  

3.2.2.4. Blend the layers
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3.2.2.4.1.Select Edit > Auto Blend Layers
3.2.2.4.2.  Leave on Stack Images 
3.2.2.4.3.  Check:  Seamless Tones and Colors
3.2.2.4.4.  Check:  Content Aware Fill Transparent Areas
3.2.2.4.5.  Select OK

3.2.2.5. Check and save the merged result
3.2.2.5.1.  These steps will create a new merged layer from the bracket 

layers, positioned at the top of the layer stack.
3.2.2.5.2.  Each of the bracket layers will now have a mask that is white 

where Photoshop used the bracket in the merged layer and black 
where it did not.

3.2.2.5.3.  Check the merged result at 100%, looking for areas where 
Photoshop’s automated process messed up.  Fix as discussed below.

3.2.2.5.4.  If all looks good or after fixing any issues, you may delete all 
of the bracketed layers leaving the merged result.

3.2.2.5.5.  Save the merged result in Photoshop to return to Lightroom.
3.2.2.6. The TK8 Plugin for Photoshop has buttons to facilitate blending 

using the Photoshop automated process.

3.3. Hand blending
3.3.1. You can blend focus stacked brackets by hand in any application that 

has layers and masks.  
3.3.2. Also, use hand blending to correct mistakes from Photoshop’s 

automated process.  

3.4. Single and special purpose apps
3.4.1. There are many apps that only process focused stack brackets or that 

do that and other specialized photo merge functions (such as HDR or 
panoramas).  The two best single purpose apps for focus stacking are:  

3.4.2.   Helicon Focus
3.4.2.1. Will render stacks that are in most RAW formats, JPEGs, TIFFs, 

or DNGs.
3.4.2.2. Rendered images can be saved as JPEGs, TIFFs or DNGs.
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3.4.2.3. Has 16 bit processing available.
3.4.2.4. Much faster than Photoshop’s automated process.

3.4.3.   Zerene Stacker
3.4.3.1. I haven’t used, but has a free 30 day trial version
3.4.3.2. Will render stacks that are JPEG or TIFF files.
3.4.3.3. Has 16 bit processing available.

3.5. Camera brand specific apps
3.5.1. Some camera brands have photo processing apps that come with the 

camera or can be obtained from the camera manufacturer and some of these
apps have focusing stacking capability.  These include:
3.5.1.1. OM Systems (used to be Olympus) has OM Workspace.  
3.5.1.2. Canon’s Digital Photo Professional.

3.5.2. There may be others as well.  Check the processing app for your 
particular camera brand if there is one.

4. REFERENCES
4.1. General

4.1.1. PhotoPills Article on Depth of Field: 
https://www.photopills.com/sites/default/files/ebooks/photopills-dof-en.pdf 

4.1.2. CamRanger Website (wirelessly control certain cameras):  
https://camranger.com/  

4.2. Focus Stacking for Macro and Closeup Photography

4.2.1. PhotoPills On-Line Macro Depth of Field Calculator: 
https://www.photopills.com/calculators/dof-macro  

4.2.2. photomacrography.net (online community dedicated to the best 
practices of photomacrography, close-up photography and 
photomicrography):  https://www.photomacrography.net/index.htm  

4.2.3. photographylife by Guest Poster, Mastering Focus Stacking for 
Stunning Macro Shots (Article, fairly simplistic without much helpful 
detail):  https://photographylife.com/focus-stacking-macro-photography  
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4.2.4. PetaPixel by Maximilian Simson, Beginner’s Guide to Focus 
Stacking for Macro Photography (Article, also relatively bare bones):  
https://petapixel.com/2019/10/02/beginners-guide-to-focus-stacking-for-
macro-photography/  

4.2.5. Andrew Lanxon Photography, Macro focus stacking methods 
Explained (Best tips I use for sharp shots) (You tube:  Goes through various
techniques for taking focus stack brackets, depending on the subject): 
https://www.youtube.com/watch?v=UWTy-44JRT4  

4.2.6. DPReview by Chris Foreman, How to Shoot better macro photos 
using a slider and focus stacking (Article): 
https://www.dpreview.com/articles/0652566916/how-to-shoot-better-
macro-photos-using-a-slider-and-focus-stacking  

4.3. Focus Stacking for Landscape Photography

4.3.1. Sean Bagshaw, Umpqua Autumn – Complete Workflow (course that 
includes lots of detailed information on focus stacking for a landscape 
image using Photoshop without and with the TL8 panel and includes 
exposure and perspective blending, and lots of other detail on taking and 
processing for the final image as well):  
https://www.outdoorexposurephoto.com/video-tutorials/complete-
workflow-umpqua-autumn/  

4.3.2. Focus Stacker Website (app for determining the number of brackets, 
distances to focus at and aperture for taking landscape focus brackets): 
http://www.georgedouvos.com/douvos/Intro_to_Focus_Stacker.html  

4.3.3. Focus Stacking in Landscape and Architectural Photography (Article 
explaining the Focus Stacker App):  
http://www.georgedouvos.com/douvos/Focus_Stacking_in_Landscape_Pho
tography.html  

4.3.4. B&H by Shawn C. Steiner, How to Use Focus Stacking for 
Landscape Photography (Article):  
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https://www.bhphotovideo.com/explora/photography/tips-and-solutions/
how-to-use-focus-stacking-for-landscape-photography  

4.3.5. Brian Matiash – Pentapixel – How to Focus Stack the Right Way for 
Landscape Photography (YouTube):  
https://petapixel.com/2021/04/08/how-to-focus-stack-the-right-way-for-
landscape-photography/   

4.3.6. photographylife by Spencer Cos, Focus Stacking Tutorial for 
Landscape Photography (Article): 
https://photographylife.com/landscapes/focus-stacking-tutorial-for-
landscape-photography 

4.3.7. Max Foster Fine Art Photography, Focus Stacking With Photoshop 
for Landscape Photography (Article): 
https://www.maxfosterphotography.com/gallery/focus-stacking-tutorial/ 

4.3.8. Fstoppers, introduction by Alex Cooke, Focus Stacking for Sharp 
Landscape Photographs (includes Youtube by Dave Morrow, Focus 
Stacking with a Wide Angle Lens): https://fstoppers.com/photoshop/focus-
stacking-sharp-landscape-photographs-618832  

4.3.9. Mark Denney, Focus Stacking Made Easy & Why I Rarely Do It! 
(YouTube):  https://www.youtube.com/watch?v=EVMdCE4_gtM  

4.4. Apps for Focus Bracketing and Focus Stacking

4.4.1. HeliconSoft Website (Helicon Remote for focus bracketing, Helicon 
Focus for focus stacking and Helicon FB Tube for focus bracketing): 
https://www.heliconsoft.com/heliconsoft-products/helicon-focus/  

4.4.2. Zerene Stacker Website (Zerene Stacker for focus stacking):  
https://zerenesystems.com/cms/home  

4.4.3. Michael Breitung, Focus Stacking Made Easy (Brief overview of 
Photoshop auto stacking, then brief introduction to Helicon Focus using the
same complex woodland scene) (YouTube):  
https://www.youtube.com/watch?v=3lG5ad-X2zw  
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4.4.4. Photography Creative Coach (Janice Sullivan), Learn How to Use 
Zerene Stacker to Make Beautiful Sharp Images (Very irritating YouTube 
with details on how to use Zerene Stacker): 
https://www.youtube.com/watch?v=b2-
U2XAf0WQ&list=PLY7_qzjCvFjidS-r7g3WFC5IAuUNsHF2r  

4.5. Focusing Rails

4.5.1. Charles Palmer Photograph, Introduction to Using Focusing Rails for
Macro Photography (YouTube): https://www.youtube.com/watch?
v=hMdDQf7nbJI  

4.5.2. Estee White, What are Focusing (Macro) Rails and What Do They 
Do (YouTube): https://www.youtube.com/watch?v=dc5Z6TcTtB8  

4.5.3. StackShot Macro Rail Website:  https://cognisys-inc.com/focus-
stacking/stackshot-pkgs.html  

4.5.4. Zerene Stacker Article, Is it better to use a focus rail or the ring on 
my lens?  
https://zerenesystems.com/cms/stacker/docs/troubleshooting/ringversusrail  

4.6. Defraction

4.6.1. Cambridge in Colour, Lens Defraction & Photography (Article): 
https://www.cambridgeincolour.com/tutorials/diffraction-
photography.htm#:~:text=Diffraction%20is%20an%20optical
%20effect,such%20as%20your%20camera's%20aperture). 

4.6.2. Image Sharpness vs. Aperture (Article):  
http://www.georgedouvos.com/douvos/Image_Sharpness_vs_Aperture.html

4.7. Camera Specific References

4.7.1. Roger Hance, YouTube Video – Focus Stacking with the Olympus E-
M1 Mk III:  https://www.youtube.com/watch?v=kQdjQIFeZV0  

4.7.2. Olympus Support by Peter Baumgarten, Using Focus Bracketing and 
Stacking in Landscape Photography (Article): 
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https://learnandsupport.getolympus.com/learn-center/photography-tips/
landscapes-nature/using-focus-bracketing-and-stacking-in-landscape 
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